
CallCenter Quick Start Guide

Please take the time to read the installation section of the QuickStart Guide 
carefully.    Failure to complete the installation process properly may result in 
failure of CallCenter to operate.

Introduction

V ³, Inc. would like to extend its appreciation for your consideration of CallCenter as the 
communications solution for your needs.    CallCenter is the first true 32-bit, multi-session, multi-
tasking Voice/Fax/Data Communications software product to be released into the market.    
CallCenter is specifically designed to take advantage of the 32-bit features available under 
Windows 95 and Windows NT4.0.    We have supplied this guide to ease the installation and first 
time use of our product.    More complete documentation is available in the on-line help files, 
which are copied to your hard drive during installation.

Installation
During the installation process it is important that you complete all fields in the dialogs where 
requested.    This information is required by CallCenter at run-time to dial phone numbers 
properly and to perform other specialized functions.

Start Windows NT, Windows 95 or 98 and insert CD-ROM into your CD-ROM drive.
From the Windows Program Manager, select Run... from the File menu.    Under Windows 95, 
click the Start button, then Run...

Type D:\SETUP if you are installing from drive D, or substitute D: with another drive letter if 
installing from another drive.

It may take several moments for the installer to prepare for the installation process, so please be 
patient.    When the Welcome screen appears, the installer has properly loaded and is ready to 
continue.    Follow the instructions on each screen filling in the appropriate information until the 
installation process is complete.    Pay special attention to the following two screens:

International Dialing Information
The "International Access Number" field refers to the number used to dial outside your country 
of origin.    This number may be the number required by your phone company to place an 
international call.    The field "Your Country" will be, in most cases, automatically detected and 
initialized along with the field "Country Code".    Please verify that these two fields contain the 
correct information based upon your current location.

Local and Long Distance Dialing Information
In this dialog the field "Area Code", in some countries, refers to a city code.    In the United 
States this field refers to a much wider area.    "Long Distance Access Number" refers to the 



number required to make a non-local call.    This number may contain the number of a long 
distance discount provider.    The remaining two fields apply to obtaining outside lines for long 
distance and local calls from within a company, organization, PBX system, etc..    These fields 
may be left blank if there are no special requirements for obtaining an outside line from your 
location.

Modem Detection
In the final stage of installation the setup program will attempt to automatically identify the 
COM port your modem is on and the specific make and model of your modem.    Make sure your
modem is plugged in and turned on before beginning the modem detection process.    In the 
unusual case where your modem model is not successfully detected, you must manually select 
your modem model.    Check you modem manual or contact your modem manufacturer if you are
not sure of the make and model of your modem.

Once CallCenter is successfully installed, you may want to read the sections below to famaliarize
yourself with CallCenter or CallCenter Pro.

Getting Started
Once CallCenter has been successfully installed, you will have several new icons available.    
Besides the readme file, which we suggest you read to obtain information on any changes to the 
product since the production of this guide, you will have one icon which you can use to start 
CallCenter Shareware version and three icons for CallCenter Pro.

CallCenter (Available in shareware and Pro version)
The CallCenter gives you easy access to a simple desktop telephone user interface. Here you can 
make use of the CallCenters telephone dialer, speakerphone, view received faxes, listen to voice 
messages, record out-going voicemail prompts, access phonebooks, system logs and make 
system
configurations. Also you have additional control by making use of a right-mouse click just above
the number two key-pad above the dialer. All novice features are easily accessable from within 
the CallCenter and it is highly recommended that if you are a novice user, you should start here 
until you have learned how to make use of all the features and functionality of the CallCenter 
Product.

COMponent WorkSpace (Available only in the CallCenter Pro version)
The COMponent WorkSpace gives you access to all CallCenter Pro software Modules.    You 
should think of the WorkSpace as the "Command Center" for accessing and using all CallCenter 
Modules.With the WorkSpace running    you can create VoiceMail windows, terminal windows, 
fax status windows, and windows for viewing received fax files.    Once these windows are 
created, you can receive VoiceMail calls and    send and receive faxes and data files.    
Furthermore, you have access to configuration dialogs for all of the modules which allow you to 
customize the product to suit your own needs.    In Novice mode, one VoiceMail status window, 
one terminal window, and one fax status window are created automatically for you.



By default, the WorkSpace is run in Advanced Mode.    Novice Mode provides access to the most
commonly used functions, such as sending a fax or sending and receiving data files.    In Novice 
Mode, VoiceMail acts as simple answering machine, by playing a supplied greeting    and then 
recording the caller's message.    By switching the WorkSpace to Advanced Mode you will be 
able to perform more sophisticated tasks, such as creating multiple mailboxes for VoiceMail, 
creating Fax-on-Demand systems, and creating your own custom cover pages and headers.    We 
suggest that you switch to Advanced Mode, from the menu Options/Workspace..., once you are 
familiar with basic operations.    The remainder of this Guide describes Novice Mode only.

When the WorkSpace is initially displayed it may have the VoiceMail, terminal, or fax window 
active.    To see the fax or data windows and have access to faxing or data communications 
options, you must first activate the appropriate window.    You can do this by either selecting the 
desired window from the Window menu or by clicking on the appropriate button in the button 
bar.    You can see all three windows simultaneously by selecting one of the tiling options from 
the Window menu.

A default phone list has been created for you.    We encourage you to explore the various buttons 
and menus while in Novice Mode.    We are confident that after only a few minutes of exploration
you will become familiar with how CallCenter COMponent Workspace works.

Using VoiceMail from TELECOMponents
TELECOMponents includes a sophisticated VoiceMail system which can be run in two distinct 
modes:    Simple Answering Machine Mode, or Advanced VoiceMail System Mode.    The system
is initially configured to run in Simple Mode, but you can change to Advanced Mode by 
accessing the "Prompts" tab in the Voice System Setup Dialog from the VoiceMail menu.    If you
do decide to change to Advanced Mode you will need to record all of the prompts required by 
advanced mode in order to ensure proper operation of the VoiceMail system.    Using advanced 
features, you can create your own customized telephony system including an unlimited number 
of personal mailboxes, personal and global Fax-on-Demand systems, and much more. 

The rest of this QuickStart Guide will refer only to Simple Answering Machine Mode.    For 
more information on Advance VoiceMail System Mode, see the online help.

The TELECOMponent window consists of two areas in Novice Mode:    A VoiceMail status area,
and a Keypad Dialer area.    The status area displays useful information related to the current 
state of the VoiceMail system.    In addition, it provides buttons which allow you to quickly 
access any received voice messages or faxes for playback or viewing.    It also provides a button 
to allow you to quickly change the out-going greeting message and another to leave a voice 
memo.    Lastly, the On/Off button allows you to turn the answering machine on and off.

Before you start using the answering machine you might want to record a personal out-going 
message.    To do this, simply make sure the VoiceMail status window is visible in the 
WorkSpace, and that it is turned on (see the On/Off button led).    Click on the Greeting... button 
and the voice message record dialog will be displayed.    At the bottom of the window you will 
see an input and output device and volume controls.    If you have a microphone plugged into 



your modem you will want to toggle the input device by clicking on the button until the 
microphone icon is displayed.    You may also want to make sure that the output device is 
configured properly as well.    To record your message, simply click on the record button and 
then speak clearly into the microphone or handset.    Click the stop button when you are done.    If
you would like to hear how your recording sounds, press the play button.    When you are done, 
click the OK button.    You now have a personalized recording    with which to greet your callers.

Your system is now ready to receive phone calls and record caller's messages.    But to give you 
an idea of how to listen your messages let's simulate an incoming caller leaving a message by 
creating a voice a memo and leaving it on the answering machine.    This time, click on the 
Memo... button and follow the same steps you followed above when recording your greeting.    
Once you have clicked OK in the record dialog you should notice that the LED in the upper left 
hand corner of the status window is blinking and the message counter reads one message.    There
are two ways to listen to any received voice messages as well as received fax files.

The easiest way is to simple click on the Play... button in the VoiceMail status window.    A 
playback dialog will appear, which is very similar to the record dialog.    Click on the play button
to listen to your newly recorded message.    Once you have listened to the message, you should 
notice that the LED stops blinking and the message counter resets to zero indicating that there 
are no unplayed messages.    It is important to realize, however, that the message you just listened
to has not been removed from the system.    It is no longer considered as a new message but it is 
still accessable from the log window.

The log window displays all types of incoming and outgoing calls.    Each log entry consists of 
detailed information about the call including:    Time of call, elapsed time, destination, number, 
and any errors.    Most importantly, the log window gives you access to received fax files, voice 
messages, and other information directly associated with the call.    The log is divided into 
mailboxes.    Each mailbox has three subfolders:    InBox, OutBox, and Archive.    You can 
double-click on the folders to display their contents.

To access the log window you can select Access Logs... from the Dialer menu or you can click 
on the yellow book in the button bar.    The left side shows the available mailboxes and the right 
side shows all of the log entries corresponding to what is selected on the left.    You can double-
click on the entries to see details for those entries or use the buttons below.    This window is 
sizable so you can size it as    desired.

Many of the features available in the log window are only accessable from a popup menu.    To 
display this menu, right-click anywhere on the surface of the log window.    The number of 
entries that the log window can contain is limited only by available disk space.    We suggest that 
you periodically delete log entries that you no longer need.    The log window is also a 
convenient place to re-send failed faxes from without having to run through all the normal steps 
required to send a fax.

How to Make a Data Connection
Make the terminal window active as previously described.    Click on the Dial button or select the



Dial... option from the Terminal menu.    You will be presented with the Dial dialog.    Enter the 
number you want to dial and select the Dial button.    The number entered will be dialed and you 
will be connected to the remote system.    Access to the phone list is also provided directly from 
the Dial dialog should you wish to dial an existing entry.

Once connected, to upload or down load a file select the upload or download button from the 
button bar or pick Upload/Download File... from the Transfer menu and follow the instructions.

How to Send a Fax
Faxes may be sent by two different methods:
Print-to-fax from any Windows application by selecting Print from the application and printing 
to the FAX32COMponent Printer which was installed on your system during setup.    When the 
Fax Wizard is displayed, follow the instructions to send the fax.
Make the fax window active as previously described.    Click on the send fax button in the button 
bar or select Send Fax... from the Fax menu.    You will be presented with the Fax Wizard.    This 
method is good when you have existing fax documents and wish to send them.    If you do not 
have any existing fax documents you should select the "Cover Only", or "Text Memo" option.    
Follow the rest of the instructions to start the send.

COMponent Server (Available only in the CallCenter Pro version)
The COMponent Server allows you to send and receive faxes and answer VoiceMail calls in the 
background without requiring that the entire COMponent WorkSpace or CallCenter be loaded 
and running.    From the Server you can view logs, view received fax files, listen to voice 
messages and see the status of current calls.    The COMponent Server provides only limited 
access to any setup options, you must run the WorkSpace to access all setup options.

Support
If you experience technical difficulties with CallCenter Pro, contact us at our Internet web site:    
http://WWW.V3INC.COM/support.html or from our home page, enter the CyberSupport area 
and follow the instructions.
Product Information.    To be informed of new products, upgrades, or patches to correct problems
in released versions of COMponents, visit our Internet web site often. In addition we will notify 
all registered users who have current email addresses on file with our company.

V ³, Inc. always creates a limited functional TEST DRIVE versions of our products and makes 
them available for FREE.    This allows you to "try before you buy".    These TEST DRIVE 
versions can be downloaded from our web site.

Information in this document is subject to change without notice.Copyright © 1994-1999 V ³, 
Inc.    All rights reserved.Windows, Windows NT, Windows 95/98 are trademarks of Microsoft 
Corporation in the USA and other countries.
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